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прийоми комп’ютерного аранжування, проаналізовано етапи творчої роботи над 
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Пояснювальна 

Музично-інформаційні технології сьогодні розвиваються дуже 

швидкими темпами. Рекомендації присвячені висвітленню нових засобів та 

методів використання комп'ютерних технологій у сучасній музичній практиці 

на прикладі опису роботи та широких можливостей одного з наймогутніших 

музичних редакторів Steinberg Cubase SX. Цей програмний продукт має 

можливості виконання повного циклу із запису, збереження, обробки, 

редагування, відтворенню цифрового саунду та зведення музики. Steinberg 

Cubase SX підходить як для домашніх студій, так і для Project-студій та 

багатоканальних комерційних систем звукозапису. Широко 

використовується як звукорежисерами, композиторами так і 

аранжувальниками. Також, методи роботи у Steinberg Cubase SX можуть 

використовуватися для вивчення студентами, що опановують відповідні 

спеціальності. Мета методичної розробки у представленні практичних 

методів роботи у музичному редакторі на основних етапах функціонування. 

Музичний звуковий редактор Steinberg Cubase SX це одна з передових 

робочих цифрових аудіо-станцій, що пропонує передові технології для 

творчих експериментів у створенні музики. 

Виконання основних операцій в Cubase SX 

У цьому розділі познайомимо починаючих користувачів програми 

Cubase SX з методиками виконання найнеобхідніших операцій. В першу чергу 

вам необхідно навчитися завантажувати існуючі файли з проектами, 

відтворювати сонг, створювати новий проект, записувати MIDI- і аудіотреки. 

Перераховані елементарні операції лежать в основі роботи над будь-якою 

композицією. Освоївши їх, ви зможете потім рухатися далі у вивченні 

складніших функцій програми.  

 

 



 

1.1. Завантаження файлу з проектом. 

У меню File виберіть команду Open. Відкриється діалогове вікно Open 

Project (мал. 1.1), призначене для завантаження файлу проекту.  

 

Мал. 1.1. Діалоговое вікно Open Project 

 

У полі Look in: слід вибрати необхідну теку. З'явиться список файлів, що 

знаходяться в ній. У цьому списку потрібно знайти і виділити файл, 

призначений для завантаження. Його ім'я відобразиться в полі File name:. 

Залишається натиснути кнопку Open і файл відкриється. Для того, щоб 

відкрити файл, можна також зробити подвійне клацання на його імені в 

списку.  

Якщо ви хочете побачити імена всіх файлів, що зберігаються у вибраній теці, 

то в списку Files of type, що розкривається: виберіть Any Type (*.*). Проте за 

допомогою вікна Open Project завантажити в Cubase SX вам вдасться файли 

тільки одного з двох типів:  

• Cubase Project File - файли проектів програми Cubase SX, що мають 

розширення CPR;  

• Nuendo Project File - файли проектів програми Nuendo, що мають 

розширення NPR.  



 

Якщо в списку Files of type, що розкривається: вибрати  Cubase Project File 

(*.срr), то в списку залишаться тільки файли проектів програми Cubase SX. 

При виборі в цьому списку строчки Nuendo Project File (*.npr) - тільки файли 

проектів програми Nuendo. Коли вибраний рядок All Types (*.cpr;*.npr) - і ті 

і інші. Таким чином, списком Files of type можна користуватися як фільтром, 

що скорочує кількість імен файлів, а також переглядаються перед 

завантаженням і полегшує знаходження необхідного файлу.  

Не потрібно думати, ніби програма Cubase SX здатна працювати тільки з 

файлами Cubase Project File і Nuendo Project File, просто файли інших типів 

можуть бути імпортовані в програму не за допомогою команди Open, а за 

допомогою інших команд. Після завантаження файлу у вікні проекту на треках 

з'явиться зображення частин. Якщо в проекті є MIDI-повідомлення, то в 

редакторові Score Editor з'являться ноти, в редакторові Key Editor - відбитки 

клавіш, а в редакторові List Editor - список повідомлень. Можна в деталях 

розглянути, як влаштована комп'ютерна музика, написана іншими авторами, 

але краще, звичайно, не тільки дивитися, але і слухати.  

1.2. Відтворення сонга 

Для відтворення сонга, завантаженого в Cubase SX, скористайтеся кнопкою 

розташованою на Transport Panel (мал. 1.2).  

 

Мал. 1.2. Transport Panel. Натиснута кнопка Play 

 

Відтворення почнеться з того моменту в композиції, якому відповідає 

положення покажчика поточної позиції. Покажчик поточної позиції видно у 

всіх тих вікнах програми, де присутня тимчасова координата. Він є 

вертикальною лінією, яка в режимі "Stop" знаходиться в тій точці тимчасової 

осі, в якій її застала команда зупинки відтворення або запису. У режимі запису 



 

і відтворення покажчик поточної позиції ковзає уздовж осі часу, відзначаючи 

ті ноти, події, відліки оцифрованого звуку, які відтворюються (записуються) в 

даний момент. Для переміщення покажчика поточної позиції на початок сонга 

служить кнопка,  до кінця – кнопка . Повільне переміщення покажчика 

поточної позиції назад або вперед, здійснюється натисненням кнопок  . 

Для зупинки відтворення натисніть кнопку . Пуск і зупинку відтворення 

можна також здійснювати натисненням клавіші «Spacebar» на комп'ютерній 

клавіатурі. На цій панелі окрім названих розташовані і інші елементи, 

призначені для управління записом і відтворенням сонга.  

1.3. Відкриття і закриття проекту 

Підготовку до запису свого першого MIDI-трека почніть з того, що 

очистіть пам'ять комп'ютера від попереднього сонга, який ви прослуховували, 

виконуючи рекомендації попереднього розділу: у меню File виберіть команду 

Close. Якщо в процесі роботи з проектом ви внесли до нього хоч одну зміну, 

то відкриється вікно, представлене на мал. 1.3.  

 

Мал. 1.3. Запит підтвердження вирішення про збереження проекту з 

внесеними до нього змінами 

 

Якщо вам потрібно зберегти проект в зміненому вигляді під колишнім 

ім'ям, то натисніть кнопку Save. Якщо ж, наприклад, зміни були внесені 

випадково або помилково і зберігати їх немає сенсу, то натисніть кнопку Don't 

Save. Натиснувши кнопку Cancel, ви тим самим відмовитеся від закриття 

проекту. В принципі, Cubase SX дозволяє тримати відкритими одночасні 

декілька проектів, один з яких є активним. Але на першому етапі освоєння 



 

програми краще не ускладнювати собі завдання і працювати тільки з одним 

відкритим проектом. Отже, більше відкритих проектів немає, а ви готуєтеся до 

запису свого першого сонга.  

 

1.1.4. Створення нового поекту 

Щоб заготовити файл для нового проекту, в меню File виберіть команду 

New Project. Відкриється діалогове вікно New Project (мал. 1.40).  

 

Мал. 1.4. Діалогове вікно New Project 

 

У вас є можливість вибрати для свого проекту один із заздалегідь 

передбачених в програмі шаблонів. Шаблон визначає:  

• скільки і яких (MIDI- і аудіотреків) буде в проекті;  

• які атрибути треків будуть встановлені для кожного з треків;  

• безліч значень різних параметрів, які в більшості шаблонів залишаються 

прийнятими за умовчанням.  

 

Термін атрибути в даному випадку означає набір великого числа 

параметрів трека.  

 

 



 

Як приклад, перерахуємо деякі з них:  

• назва трека;  

• Channel - номер MIDI-канала, закріпленого за треком;  

• Bank and Programs - вибраний для трека MIDI-инструмент;  

• Input - порт введення;  

• Output - порт виводу;  

• Volume - значення параметра, що визначає початкову гучність, 

встановлену для трека;  

• Pan - значення параметра, що визначає початкову панораму трека 

(положення джерела звуку, що задається на стереопанорамі);  

• перелік підключених до трека MIDI-ефектів реального часу або VST- 

плагінів і значення їх параметрів;  

• Delay - значення параметра, що визначає зсув в часі подій на треку щодо 

тактової сітки.  

 

Серед шаблонів проектів, що містяться у вікні New Project, 

представленому на мал. 1.4, є ті, що поставляються разом з програмою, але є і 

"саморобні". З часом ви самі зрозумієте, з якими конфігураціями програми вам 

доводиться працювати найчастіше, і збережете їх у вигляді шаблонів. Для 

цього потрібно скористатися командою File > Save as Template, у вікні 

діалогу, що відкрилося, задати ім'я шаблону і натиснути кнопку ОК. Якщо 

вибрати шаблон Empty (див. мал. 1.4), то відкриється абсолютно чисте і 

порожнє вікно проекту, і далі вам потрібно буде своїми силами створювати в 

нім треки і встановлювати їх атрибути. Зараз же ми пропонуємо вам обійти 

проблему установки атрибутів треків, вибравши шаблон проекту, 

пристосований спеціально для запису MIDI-треків. У вікні New Project 

виділіть рядок 16 Track MIDI Sequencer і натисніть кнопку ОК. В результаті 

спочатку відкриється вікно Select directory, в якому слід вказати теку для 

зберігання файлу з майбутнім проектом.  



 

 

Мал. 1.41. Вікно Select directory 

 

 

Мал. 1.42. Вікно Cubase SX Project з вибраним шаблоном проекту 

Ви можете натиснути кнопку ОК, вікно Select directory закриється, а як 

тека проекту буде вибрана поточна тека. Можна натиснути кнопку Create і 

створити нову теку, вказавши її ім'я у вікні Select/Create new directory, що 

відкрилося. Після того, як і в цьому вікні ви натиснете кнопку ОК, проект 

нарешті буде створений, а перед вами з'явиться у всій красі одне з основних 



 

вікон програми - вікно проекту Cubase SX Project (мал. 1.42). Саме у цьому 

вікні наочно представлена структура шаблону проекту:  

• у нім 16 треків (якщо видно не всі треки, можна скористатися 

вертикальною смугою прокрутки);  

• номери треків спеціально встановлені рівними номерам MIDI-каналів 

(так простіше орієнтуватися);  

• початковий рівень гучності для кожного трека встановлений рівним 100 

одиницям (максимально можливе його значення складає 127);  

• джерела звуку на всіх треках панорамовані в центр (Pan = Off);  

• ні для одного трека не вибраний MIDI-инструмент (bnk:off, prgroff).  

Фактично це означає те, що команда зміни інструменту взагалі не 

посилалася синтезатору. Тому, найімовірніше, на даному каналі звучатиме 

патч Grand Piano, який зазвичай автоматично встановлюється при 

ініціалізації синтезатора для всіх MIDI-каналів окрім MIDI-канала 10, 

призначеного для ударних інструментів.  

Ці і деякі інші відомості про атрибути трека ви дізнаєтеся, перемикаючи 

секції інспектора треків, розташованого справа. Щоб надалі не відволікатися, 

є сенс до початку запису вибрати для всіх треків відповідні MIDI-інструменти 

(програми, звуки, патчи, голоси). На перших кроках, поки ви ще не вмієте 

користуватися багатющими можливостями віртуальних VST-інструменті, 

цілком можна обійтися звуками, наявними в стандартному банку General 

MIDI вашої звукової карти. Для трека MIDI 01 підберіть відповідне по 

звучанню піаніно, а сам трек можна перейменувати в Piano, набравши це слово 

в полі введення, розташованому у верхній частині панелі інспектора. Для трека 

MIDI 02, перейменувавши його в Bass, візьміть один з басових інструментів. 

Для трека MIDI 03, перейменувавши його в Accompanement, виберіть, 

наприклад, одну з гітар і так далі За замовчанням в даному шаблоні для 

кожного із 16-ти треків вибрано всі канали введення MIDl-данних, що 



 

існують у вашій системі (in: All MIDI Inputs). Це чудово підходить для того, 

щоб записувати на трек результати вашої гри на MIDI-клавіатурі, а ось порт 

виведення MIDI-повідомлень за замовчанням не вибраний (out: Not 

Connected). Виберіть в списку Output, що розкривається, замість рядка out: 

Not Connected який-небудь інший рядок, що означає назву порту управління 

синтезатором вашої звукової карти або віртуальним синтезатором, 

підключеним до Cubase SX. 

Спершу, рухаючись від простого до складного, виберіть порт звукової 

карти, встановленої у вашому комп'ютері. Якщо вибрати її, то замість окремих 

списків bnk і prg: з'явиться загальний список Bank and 

Programs, в якому приховані всі MIDI-інструменти, відповідні стандарту 

General MIDI.  

 

MIDI-інструмент можна вибрати двома способами:  

• клацаючи на стрілках списку Bank and Programs, що розкривається, 

кожного з треків, ви послідовно перегортуватимете список MIDI-

інструментів;  

• подвійним клацанням на полі цього списку, що розкривається, ви 

отримаєте доступ до вікна, в якому перераховані всі банки і всі MIDI-

інструменти поточного банку (мал. 1.43).  

Мал. 1.43. Вікно вибору MIDI-інструментів 



 

Вибір MIDI-інструменту для трека зводиться до виділення одного з 

елементів даного меню. За бажанням ви можете використовувати не тільки 

стандартний банк GM, але і додаткові банки інструментів у форматі Sound 

Font 2, або банки віртуальних синтезаторів, підключених до Cubase SX. З 

метою спрощення процедури пошуку MIDI-інструментів у вікні, 

представленому на мал. 1.43, передбачений фільтр. Наберіть в полі Filter ім'я 

інструменту який ви шукаєте і відповідний рядок же з'явиться у вікні. Якщо 

ви не пам'ятаєте повного імені MIDI-інструмента - не страшно. Список, що 

відображається у вікні, можна істотно скоротити. Для цього досить набрати в 

полі Filter хоч би декілька букв, що входять в ім'я. На мал. 1.44 представлений 

приклад: набрані букви str, в списку залишилися імена тільки тих 

інструментів, в які ці букви входять.  

 

Мал. 1.44. Приклад застосування фільтру імен MIDI-інструментів 

Тепер, коли і MIDI-клавіатура підключена, і MIDI-інструменти для 

треків вибрані, можна послухати, як вони звучать, а заодно і відпрацювати 

кожну з партій майбутньої композиції. Звучати буде той трек (ті треки), на 

якому (яких) ви натиснете одну з кнопок:  або . 



 

1.4. Збереження проекту. Формати файлів 

Запис ще не почався, але ми б радили вже зберегти ваш проект. Під 

проектом розуміється файл, в якому окрім звукових і МIDI-повідомлень 

містяться також всілякі установки (створені треки, підключені ефекти, дані 

автоматизації управління віртуальним мікшером, вибрані параметри, відкриті 

вікна, встановлені режими, поточна позиція, з якою почнеться запис або 

відтворення, і багато що інше). Для першого збереження файлу з поточним 

проектом служить команда Save As меню File. По цій команді відкриється 

діалогове вікно Save As, зображене на мал. 1.45.  

 

Мал. 1.45. Діалогове вікно Save As 

У цьому вікні виберіть каталог (у списку Look in, що розкривається:), 

введіть ім'я (у полі File name:) і натисніть кнопку Save. У вікні Save As є 

список Files of type, що також розкривається:, тому може створитися 

враження, ніби є вибір типу і розширення файлу, що зберігається. Проте в 

Cubase SX (на відміну від попередніх версій програми Cubase) проект можна 

зберігати в єдиному форматі: Cubase Project File (з розширенням CPR). Є 

можливість експортувати з Cubase SX вміст MIDI-треків в MIDI-файлы, а 

вміст аудіотреків -в WAV-файлы (команди File > Export > MIDI File і File > 

Export > Audio Mixdown). Це може стати в нагоді, якщо роботу над MIDI або 



 

аудіоданими необхідно буде продовжити в якійсь іншій програмі. Відмітимо, 

що для забезпечення деякої сумісності з попередніми версіями програми 

передбачено імпортування в Cubase SX WAV-файлов і MIDI-файлов, а також 

файлів з такими об'єктами, як сонг, аранжування і частина (команди File > 

Import > Audio File..., File > Import > MIDI File..., File > Import > Cubase 

Song, File > Import > Cubase Arrangement, File > Import > Cubase Part...). 

Слід враховувати, що імпортування даних з файлів перерахованих типів (окрім 

WAV- і MIDI-файлів) здійснюється з деякими втратами.  

1.5. Запис MIDI-трека 

Запис MIDI-композиціі можна здійснювати різними способами, але 

найзручніше робити це за допомогою MIDI-клавіатури. Це і швидше і 

дозволяє зберегти стиль виконавця. Без MIDI-клавіатури вам навряд чи 

вдасться додати звучанню твору "драйв", характерний для майстрової гри "в 

живу". Запис можна починати з будь-якого трека, вибраного вами. Для цього 

слід в полі необхідного трека натиснути маленьку кнопку  (Record Enable). 

Кнопка буде мати червоний колір. Награвати партії композиції на MIDI-

клавіатурі зручно під метроном. 

Локатори 

У програмі Cubase SX є локатори, що виконують різні функції. Цих 

локаторів два - лівий і правий (Left Locator, Right Locator). Якщо ви 

натискаєте на транспортній панелі кнопку  (Record), коли програма 

знаходиться в режимі зупинки, то запис почнеться від місця, позначеного 

лівим локатором. Положення локаторів вказані графічно на лінійці у верхній 

частині вікна проекту  (локатор можна 

переміщати уздовж лінійки, вхопившись за нього курсором миші), а також 

цифрами в лівій частині транспортної панелі (мал. 1.46).  

 



 

 

Мал. 1.46. Фрагмент транспортної панелі. Індикатор положення локаторів 

Існує також спосіб точної установки локатора. У програмі Cubase SX 

будь-які цифрові поля (у тому числі і поля значень локаторів) міняти дуже 

просто: клацання в цьому полі лівою кнопкою миші робить поле доступним 

для редагування. Щоб збільшити або зменшити значення, скористайтеся 

клавішами вгору і вниз. Для того, щоб почати запис "спочатку", тобто з 

першого такту, встановіть лівий локатор в положення 0001.01.01.000, що 

означає "перший такт, перша четвертна доля, перша четверта частина першої 

долі, нульовий тік".  

Музичний час в Cubase SX 

У Cubase SX відлік музичного часу організований своєрідно. Розглянемо 

для прикладу показники лічильника, який знаходиться на транспортній панелі 

і відображає положення покажчика поточної позиції (мал. 1.47).  

 

Мал. 1.47. Фрагмент транспортної панелі.  

Лічильник покажчика поточної позиції 

Відлік часу ведеться наступним чином:  

1. Підраховуються такти і їх кількість відображається числом, 

розташованим зліва від лівої крапки (у прикладі на мал. 1.47 це число 

складає 0002). На перший погляд здається, що в проекті може бути не 

більше 9999 тактів. Насправді це не так. В міру необхідності в 

лічильнику тактів з'являються додаткові розряди.  

2. В середині кожного такту підраховуються долі (у прикладі на мал. 1.47 

це число складає 01). Кількість долей в такті визначається тим, який 



 

музичний розмір ви задасте (дріб в правій області транспортної панелі), 

максимальне дозволене число долей складає 16.  

3. В середині кожної долі підраховуються частини долі (у прикладі на мал. 

1.47 це число складає 01). Кожна четвертна доля автоматично ділиться 

на 4 частини, восьма - на 2, шістнадцята доля на частини неподільна (у 

ній поміщена рівно одна частина).  

4. Кожна частина долі у свою чергу ділиться на 120 тіків (у прикладі на 

мал. 1.47 це число складає 000). Рахунок тіків ведеться від 0 до 119. 

Таким чином, на шістнадцяту частку доводиться 120 тиків, а на 

четвертну - 480. Роздільна здатність Cubase SX рівна 480 тикам на 

чверть.  

Тепер в правій частині транспортної панелі встановіть потрібний 

музичний темп і розмір (у полях, розташованих праворуч від кнопок Click і 

Master). Розмір встановлюється в традиційному форматі, наприклад, 3/4, 6/8, 

2/2 і тому подібне Темп встановлюється в стандартних одиницях "кількість 

долей в секунду". Для того, щоб легко було зіграти уривок рівно, натисніть 

кнопку Click на панелі управління. В цьому випадку метроном "відбиватиме" 

кожну долю такту. Для того, щоб швидко, "на ходу" включати або вимикати 

кнопку Click, можна просто натискати клавішу < З >.  

Перша спроба запису з MIDI-клавіатури 

Отже, MIDI-трек вибраний, лівий локатор встановлений, метроном 

підготовлений, можна починати запис. Приступайте до запису, натиснувши на 

транспортній панелі кнопку  (Record), або зірочку на клавіатурі. Награйте 

задуману вами партію на МIDI-клавіатурі. Для завершення запису фрагмента 

натисніть на транспортній панелі кнопку  (Stop), або на комп'ютерній 

клавіатурі натисніть <Spacebar>, або двічі клавішу <0> Записані MIDI-

повідомлення з'являться на MIDI-треках в об'єктах, які в термінології Cubase 

SX називаються частинами. Про частини ми говоритимемо ще не один раз. 



 

Поки що для простоти можете вважати, що в результаті запису ви заповнили 

MIDI-повідомленнями деякі фрагменти MIDI-треків. Якщо вам не 

сподобалося те, що ви записали (а в самий перший раз так воно, ймовірно, і 

буде), можна відмінити результати запису. Для цього в меню Edit виберіть 

пункт Undo або натисніть комбінацію клавіш <Ctrl> + <z>. Зіграйте на MIDI-

клавіатурі по черзі всі партії. Пам'ятайте, що вам не обов'язково записувати 

музичний твір цілком. Його можна "зібрати по частинах" з окремо записаних 

і відредагованих фрагментів. Записані партії потрібно відредагувати, 

усунувши помилки. Потім слід рознести віртуальні джерела звуку по 

стереопанорамі і добитися необхідного балансу в сумісному звучанні 

партій композиції для кожного трека. Можна обробити деякі MIDI-треки 

ефектами (наприклад, реверберацією і хорусом), але особливо захоплюватися 

цим не слід. Надалі вам, швидше за все, захочеться переписати партії з MIDI-

треків на аудіотреки з тим, щоб вже до них застосувати набагато 

різноманітніші і цікавіші аудіоефекти. Тому потрібно залишати початкові 

MIDI-треки "сухими": без яких-небудь обробок.  

1.6. Запис звукових даних із зовнішнього джерела 

Сподіваємося, що перший досвід запису MIDI-акомпанемента у вас 

вдався, та і файл з проектом ви зберегти не забули. У такому разі можна 

починати підготовку до доповнення отриманого запису вокальною партією 

або партією у виконанні реального акустичного музичного інструменту. Але 

спочатку потрібно підключити мікрофон до звукової карти.  Припустимо, у 

вас вже є мікрофон. Він підключений до мікрофонного входу звукової карти 

або безпосередньо, або через відповідний підсилювач, або через мікшер. При 

записі вокалу також знадобляться навушники. З їх допомогою виконавець 

слухатиме акомпанемент. Взагалі, для запису і редагування звуку призначені 

спеціальні програми - звукові редактори, наприклад, Cool Edit Pro. (Adobe 

Audition), Wave Lab, Saund Forge. Можливості такого редактора було б досить, 

якби ви вирішили записувати тільки голос. Цими програмами можна було б 



 

обійтися також і при записі вокалу, якби у вашому розпорядженні вже була 

"мінусова" фонограма майбутньої пісні, збережена в WAV-файлі. І вони, 

звичайно, стануть в нагоді вам, коли справа дійде до "чищення" вокальної 

партії. Але багато музикантів приступають до запису вокалу відразу ж після 

того, як в MIDI-редакторі (секвенсорі) створять MIDI-треки з акомпанементом 

(MIDI-трек - це трек, що асоціюється з MIDI-портами введення і виводу, 

призначений для зберігання MIDI-даних). І це досить розумно. Адже 

відтворення MIDI-треків, скільки б їх не було, займає меншу частину ресурсів 

комп'ютера в порівнянні з відтворенням оцифрованого звуку. В принципі, 

MIDI-інструмент ніколи не пізно переписати на аудіо-треки (аудіотрек - трек, 

що асоціюється з аудіопортами введення і виводу, призначений для 

зберігання аудіоповідомлень - повідомлень про початок відтворення 

звукових файлів). І навіть бажано, врешті-решт, зробити це для того, щоб 

з'явилася можливість обробити кожен інструмент різними звуковими 

ефектами. Та все ж виходить, що неминучий етап одночасної роботи з аудіо- і 

MIDI-треками, тому без універсального музичного редактора не обійтися. 

Зрозуміло, як такий редактор в даній випадку ми розглядатимемо Cubase SX. 

Завантажте в програму файл з тією MIDI-композицією, до якої збираєтеся 

дописувати вокальну партію. Відкриється вікно проекту програми Cubase SX. 

1.7. Створення аудіотрека 

Вам потрібно створити аудіотрек для запису вокалу. Для цього в меню 

Project виберіть команду Add Track > Audio. До MIDI-треків, що існували 

раніше, додасться аудіотрек (мал. 1.48). Він поки чистий. Щоб працювати було 

зручно, можна збільшити масштаб відображення треків по вертикалі кнопкою 

Zoom In Vertical, розташованою в нижній області вертикальної лінійки 

прокрутки. Для створеного трека потрібно задати ряд його параметрів - 

вибрати атрибути. Доступ до атрибутів здійснюється за допомогою елементів 

інтерфейсу, розташованих на полі інспектора. Не всі з представлених там 

можливостей знадобляться вам при записі звуку з мікрофону. Наприклад, не 



 

використовуватимемо поки аудіоефекти. До речі кажучи, початковий запис 

доцільно виконати без якої-небудь обробки ефектами і у такому вигляді 

зберігати, а експериментувати з її копією. Не будемо також змінювати 

передбачені за умовчанням початкові значення рівня гучності (Vol = 0.0) і 

панорами (Pan = З, буде відчуття, що джерело звуку розташоване в її центрі). 

Ось без чого не можна обійтися, так це без портів введення і виводу.  

 

Мал. 1.48. Вікно Cubase SX Project з частинами, записаними на MIDI-треках 

і створеним аудіотреком 

Вибір портів введення і виводу 

Для вибору порту введення звукових даних служить список 

(Input Routing), що розкривається , 

розташований на панелі інспектора. Залежно від формату аудіотрека (моно або 

стерео) стереофонічні порти можуть бути логічно розбиті на два 

монофонічних:  

1. Джерело звуку лівого каналу.  

2. Джерело звуку правого каналу.  



 

Стереофонічному джерелу звуку повинен відповідати стереофонічний 

аудіотрек. А якщо ви ведете запис за допомогою єдиного монофонічного 

мікрофону, то не обов'язково вибирати стереофонічний формат трека. Звук все 

одно буде монофонічним, а такий трек займе файл подвоєного об'єму в 

порівнянні з монофонічним варіантом. Для перемикання формату трека з 

монофонічного на стереофонічний і навпаки слід скористатися кнопкою 

Stereo Switch, розташованою на панелі інспектора. Вид кнопки змінюється: 

 означає, що включений монофонічний формат,  - стереофонічний. Але 

не поспішайте турбуватися з приводу монофонічності фонограми записаного 

голосу. Навіть у професійних студіях вокал, як правило, записується в 

монофонічному форматі. Щоб виконати стереозапис голосу, потрібні особливі 

умови або пара певним чином розташованих ідентичних мікрофонів, або 

спеціальний стереомікрофон. Монофонічний формат трека ніколи не пізно 

перетворити в стереофонічний, але робити цього вам, швидше за все, не 

доведеться, оскільки додати запису об'ємне псевдостереофонічне звучання 

можна за допомогою обробки ефектами, заснованими на затримці сигналу. 

Для того, щоб звукові дані з трека поступали на певний пристрій відтворення, 

необхідно вибрати відповідний порт виводу. На даному етапі навчання роботі 

з Cubase SX просто переконайтеся, що в списку ( Output 

Routing) вибрана основна шина - віртуальний порт виводу, що позначається  

буквами BUS 1. Значення деяких параметрів, що відповідають за якість запису 

і відтворення звуку, вибираються у вікні Project Setup, яке відкривається 

командою Project > Project Setup. Вибір пристроїв відтворення звуку 

здійснюється у вікні Device Setup (команда Devices > Device Setup). Формат 

звукових даних (від стерео до 5.1) вибирають у вікні VST Master Setup 

(команда Devices > VST Master Setup). За допомогою опцій цих вікон 

проводиться витончена конфігурація каналу цифрового звуку. Але це вже 

вищий пілотаж. Для первинного ж освоєння технології запису звуку цілком 

достатньо буде значень параметрів, які передбачені за умовчанням.  



 

Настройка рівня сигналу 

Останнє, що залишилося зробити до початку запису, - встановити рівень 

сигналу, що поступає на аналого-цифровий перетворювач звукової карти. За 

допомогою мікшера звукової карти вам слід провести необхідну комутацію і 

встановити оптимальний рівень вхідного сигналу. Намагатися детально 

описувати цю процедуру немає сенсу, оскільки звукові карти і відповідні ним 

драйвери мікшерів можуть бути самими різними. Контролюється рівень за 

допомогою вимірника рівня сигналу програми Cubase SX (мал. 1.26). Після 

завершення всіх підготовчих операцій нарешті можна і приступити 

безпосередньо до запису звуку на аудіотрек. У полі трека (або на панелі 

інспектора) вікна Cubase SX Project натисніть маленьку кнопочку  (Enable 

Record), вона забарвиться в червоний колір, що означає готовність трека до 

запису. Після цього співак повинен прочистити горло, влаштуватися зручніше 

перед мікрофоном, набрати в легені повітря і чекати, коли ви натиснете кнопку 

 (Record) на транспортній панелі програми Cubase SX. Натискайте! Поле 

трека стало червоним. Зазвучав акомпанемент, пісня полилася. Отже, ми 

розповіли починаючим комп'ютерним музикантам про те, як виконати 

найнеобхідніші операції: підключити MIDI-клавіатуру і мікрофон до звукової 

карти, завантажити, зберегти і відтворити файл з проектом, записати MIDI- і 

аудіотреки.  
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